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1 INTRODUCTION 

RST’s Inclinalysis™ software is a powerful companion to the RST Digital 
Inclinometer System. This software allows the user to quickly and efficiently reduce 
large volumes of Inclinometer data into a variety of formats suitable for presentation. 

In addition to classic Vertical Inclinometer data, Inclinalysis™ will process and 
display Horizontal Inclinometer data in various formats. 

 

NOTE: For additional support, please contact RST Instruments (refer to Section 14 
of this manual for contact details). 

 

2 GETTING STARTED 

2.1 INSTALLING THE SOFTWARE 

1. Download Inclinalysis™ software: 

a) Go to the Inclinalysis Digital Inclinometer Software product page on the 
RST website (https://rstinstruments.com/product/inclinalysis-digital-
inclinometer-software/). 

b) Scroll down to the Downloads section and download “Inclinalysis Setup 
Files”. 

c) Once the download is complete, launch the setup files. 

2. Follow the on-screen instructions to install the software, specifying the location of 
the folders. 

3. Install the special USB security key driver when prompted by the installation 
wizard. 

 

CAUTION: Please ensure that the USB security key driver is installed on the computer 
before inserting the key into the USB port.  

Follow the step-by-step instructions in section 12 of this manual for details steps to 
install the USB security key driver.  

In case of USB device driver installation problems, please refer to section 13 for 
troubleshooting tips. 

 
4. Insert the USB security key into an available USB port on the computer. 

 
5. Launch the software by choosing it from the program list under the Start Menu. 

https://rstinstruments.com/product/inclinalysis-digital-inclinometer-software/
https://rstinstruments.com/product/inclinalysis-digital-inclinometer-software/
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2.2 DEMO SOFTWARE 

If the full version of the Inclinalysis™ software has not been purchased, it will run in 
demo mode.  The user will be able to access all the functions of the registered 
software, however, plots and reports cannot be saved, printed or exported to a 
metafile.   

Installation of the program is the same as in Section 2.1. Demo files are also 
included with the demo software to enable the user to explore many features of 
Inclinalysis™ software. Press F1 anytime to activate context sensitive help system. 

2.3 HELP SYSTEM 

The Inclinalysis™ software contains an extensive, built-in help system which can be 
activated anytime by pressing F1 or the ‘Help’ icon. Context sensitive help is 
available for most tasks and dialog boxes; the “What’s This” question mark icon 
allows for quick pop-up help. Help resources are supplemented by keyword index 
and keyword search. 

3 PLOT TYPES 

The RST Digital Inclinometer creates several different plot types to view and analyze 
Inclinometer survey data. These plot types can be created and edited once a new 
Graph View has been opened (see Section 4.2) and are in the top tool bar. 

3.1 MEAN DEVIATION 

During an Inclinometer survey, readings are taken with a Probe at intervals 
throughout the entire depth of the borehole. The Probe is then turned 180 degrees, 
and the survey is repeated. Ideally, when each specific reading is summed, the result 
should be zero (see checksum, Section 3.5). The sum is not zero as the Probe 
always has a slight zero offset.   

To minimize the effects of this offset, an average is taken of the difference of the two 

readings (i.e. 






 − −+

2

AA
 ). The mean deviation plots this average data for each 

depth. 

3.2 INCREMENTAL DISPLACEMENT 

The incremental displacement plot uses the mean deviation data and compares it to 
the baseline survey file. In turn, this plot reveals the exact depth where 
displacements are occurring. It has the advantage that errors such as checksum, 
cable stretch, cross axis and casing spiral do not have a chance to accumulate 
(unlike in the cumulative displacement plot). 
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3.3 ABSOLUTE POSITION 

This plot reveals the actual shape of the Inclinometer casing as it has been installed.  
Although it does not show displacements as well as the other plots, it can reveal 
whether potential errors are being caused by non-vertical casing. 

3.4 CUMULATIVE DISPLACEMENT 

The most common presentation of Inclinometer data, the cumulative displacement is 
the sum of the displacements from the base of the borehole. This plot shows the 
change in the position of the casing since the first set of readings. Caution must be 
exercised as this plot is very sensitive to errors in the Probe, such as excessive 
checksums, cable stretch, cross-axis and casing spiral error. Changes in Probe 
calibration (drift) over time can affect the data significantly if there has been 
significant movement of the casing from vertical. In general, rapid deviations from the 
center line over a few sets of readings are more important than gradual changes. 

3.5 CHECKSUM 

A checksum’s primary function is to verify data integrity (or quality) during a survey.  
A checksum is the mathematical addition of the A+, A- and the B+, B- readings from 
identical depths in the borehole. The checksum plot displays the checksum data for 
each depth interval. The most common cause of inaccuracies in Inclinometer data is 
due to errors in Probe placement. Large checksums are often the result of these 
placement errors. Any jumps in the checksum data can indicate a questionable 
reading. Small drifts in checksum data over time can indicate aging and the bumps 
and shocks a Probe takes over normal use.   

 

NOTE: RST recommends calibration of the Probe on an annual basis, or more 
frequently if the checksums confirm a problem with the Probe. 
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3.6 TIME PLOT 

The Time Plot is a useful tool for monitoring movements at a specific depth over 
time. The individual depth can be chosen using the drop-down menu available in the 
main tool bar (see Section 8.3). 

 

FIGURE 3-1  TIME PLOT AND DEPTH OPTION 

The individual depths can be scrolled through using the arrow key and the 
corresponding depth will be displayed on the current plot view. The time plot will plot 
all the cumulative displacement data from each survey file for the corresponding 
depth, revealing trends and rates of movement at that specific depth interval. 

For information on the time plot and displaying movement zones, please see Section 
8.7. 
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3.7 VECTOR PLOT 

The Vector Plot reveals the change in the magnitude and direction of the casing at a 
specific or user defined depth interval using the Incremental Displacement data from 
each of the borehole profiles. The vector is the point in the graph, while the 
interconnected lines are used to show the change in vector over the course of all the 
readings. As with the time plot, the depth can be easily changed by using the depth 
scroll box found on the main tool bar (screen area in red circle, Figure 3-1).  It is 
possible to display both the Vector and Time plots on the screen simultaneously, 
which is a very useful feature for analytical purposes (see Figure 8-23 for an 
example). 

 

FIGURE 3-2  VECTOR PLOT 

In this manner, the user can scroll through the specific intervals and see the resultant 
change in magnitude and direction for that depth over time. 

For more information of vector plots and movements zones, please refer to Section 
8.7.  

 

 

Depth Drop Down Box 
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3.8 POLAR PLOT 

The polar plot shows displacement versus angle when viewed down the borehole. 
The plot type can be selected from the graph menu. The following plot types are 
available: 

• Mean Deviation 

• Incremental Displacement 

• Absolute Position 

• Cumulative Displacement 

The file legend can be used to turn on and off individual plots for clarity. 

 

FIGURE 3-3  POLAR PLOT 
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4 MENU ITEMS 

The following sections describe the menu options available with Inclinalysis™. 

4.1 BOREHOLE MENU 

Open Borehole: Opens a dialog box with which the user can browse and select a 
project, site and a specific borehole to open. The software requires the specific 
directory structure created by the RST Digital Inclinometer System (please refer to 
Section 5). 

Recent Boreholes: Keeps a list of the 3 most recent boreholes that have been 
opened. 

Report: Allows the option to open another report, save the current report or print the 
report. Multiple reports can be created for a single borehole which allows the user to 
have custom plots and views for each specific report. Print Report prints the entire 
report (of all the windows that are currently open). For more information on creating 
reports, please refer to Section 6.5. 

Add/Remove Borehole Files: Opens a dialog in which the user can specify which 
survey files are to be displayed with the program (Figure 6-9). The user can specify 
which file is displayed and the base file, along with header information. 

Print…: Prints the current report on any local or network printer. 

Page Setup: Allows the user to set the margins and place a border around all plots. 

Print Setup: Edits and sets specific printer options.  

Export TextView Data…: Exports and saves data from the Text View. Please refer 
to Section 7.3. 

Export Metafile…: Places the plotted graph into a metafile document. 

Options…: Changes various software options. 

Close:  Closes the current borehole data and plots that are open with the program. 

Exit:  Exits the RST Data Reduction Software. 
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4.2 VIEW MENU 

Open View…: Opens a dialog box where the user can open and close the various 
available plot types. Also allows the option for copying, renaming or deleting the plot 
types as seen below: 

 

FIGURE 4-1  OPEN VIEW DIALOG 

New View: Creates a new plot on the screen. The user has the option of a graph 
view, text view, plan view, vector plot, or time plot: 

• Graph View: Opens a window in which the user can plot graphs of the data.  
Shortcuts to change plot types are provided in the tool bar below the menu 
headings. Available graph types are outlined in Section 3. 

• Text View:  Opens a window in which the user can view the raw and 
calculated data in table format. Options allow the user to quickly switch 
between raw data, checksum, mean deviation, incremental displacement, 
and cumulative displacement. A directory tree appears on the left which 
allows the user to navigate between different data sets. Please refer to 
Section 7.3. 

• Time Plot: Opens a window in which the Inclinometer data is plotted versus 
time for a specific or user-defined depth interval. 

• Vector Plot: Opens a window which plots the vector direction of the A and B 
axes for a specific or user-defined depth interval. 

Save View: Saves the current view. 

Save View As…: Saves the current view under a chosen name. 

Save Custom Settings: Saves the current graph settings as custom settings. 

Force Custom Settings: Applies previously saved custom settings to the current 
graph view. 
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Add Files To View…: Adds borehole data files to the current view. 

Toolbars: Reveals and hides the file toolbar, the plot type and graph options 
buttons. 

Status Bar: Reveals and hides the status bar at the bottom of the screen. 

Language: Chooses different language.  

 
NOTE: Language modules are an optional add-on component. 

 

4.3 EDIT MENU 

Header…: Allows the user to change the header options for the borehole. Borders 
can be added along with custom titles and other features (Figure 7-3). 

Plot Properties…: Opens a window which shows the current data sets loaded for 
the borehole (including those which are disabled). Left clicking a data set brings up 
its properties menu where the user can change the colour and other text properties. 

Layers…: Opens dialog box listing all underground settlement layers indicated on 
graphs. 

Reading Units: Opens a fly-out in which the user can choose the x-axis display 
units. Options are millimeters, meters, inches and feet. 

Movement Zone…:  Allows the user to specify movement zones to be displayed on 
both the time and vector plots (see Section 8.7). 

Bias-Shift Correction…: Apply a bias-shift correction to individual survey files 
contained within the report. A separate bias-shift can be used for both the A and B 
axes. For more on Bias-Shift errors, please refer to Section 8.8. 

Spiral Correction…: Applies a spiral correction to all data contained in the report.  
For more on Spiral Correction, please see Section 8.9. 

Reference…: Change between a top or bottom reference for the Inclinometer data 
(Section 8.3). 

Borehole Changes…: Opens dialog box listing all collar level changes and borehole 
depth limitations. 
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4.4 WINDOW MENU 

Cascade: Cascades all currently open windows across the screen. 

Tile Horizontally: Tiles all currently open windows horizontally across the screen. 

Tile Vertically: Tiles all currently open windows vertically across the screen. 

A list of the current open views is also available allowing the user to flip between 
views on the screen. 

4.5 HELP MENU 

Help Topics: Opens a standard Windows™ help menu where the user can search 
on help topics for the program. 

Manual: Opens software manual.  

 
NOTE: Adobe™ Acrobat Reader is required for viewing software manual. 

 
About Inclinalysis…: Displays the running version and release date of the software. 
 

5 DATA STRUCTURE 

The RST Digital Inclinometer system creates a specific data structure in which all the 
sites and borehole survey files are found.  On the Pocket PCTM under My 
Documents, a folder is created called DigitalInclinometer. Under this folder name, 
two additional folders are created which correspond to the site name and the 
borehole name as seen below: 

 

FIGURE 5-1  DATA STRUCTURE 

In this case (Figure 5-1), the site name is RST and the name of the borehole is 
Parking Lot.  When opening a borehole with the program (see Section 6), the user 
must browse to and open the folder DigitalInclinometer. The software automatically 
recognizes the hierarchy of the folders. The user can then add specific borehole 
survey files to their view, as described in Section 6.1. Once the program is set up to 
recognize the folder, new survey files can be simply copied into the corresponding 
site or borehole folder. The new data can then be displayed in the program using the 
Add/Remove Borehole Files feature (described further in the following chapter). 

 

Site Name 

Borehole Name 
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NOTE: Once the initial site and borehole is created in Inclinalysis™, the program can 
load in Inclinometer survey files from various locations.   

However, it is recommended that all the survey files be kept in the same folder to 
keep them organised. 

 

6 USING THE SOFTWARE 

6.1 CREATING A NEW SITE OR BOREHOLE 

 

NOTE: Vertical Inclinometer data is used to illustrate examples in the following 
sections.  

Users should treat data from horizontal Inclinometers the same. 

 

When the program is launched for the first time, the following screen will appear: 

 

FIGURE 6-1  OPENING SCREEN 

 

NOTE: Before starting to create a new site or borehole, the location and names of all 
the raw Inclinometer data must be confirmed. 
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1. Under the Borehole menu, select Open Borehole and the following dialog 
box will appear: 

 

FIGURE 6-2  NEW BOREHOLE SELECTION 

2. Press the Browse Files button to navigate to the folder RST Digital 
Inclinometer site and borehole files will be stored. Upon clicking on Browse 
Files, the following screen will appear: 

 

FIGURE 6-3  BROWSE NEW FILES DIALOG 

3. Highlight the desired folder and press OK. 
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4. The Borehole Selection screen will re-appear (Figure 6-4). Since the new 
folder is empty, the Borehole Selection dialog will contain no entries. 

 

FIGURE 6-4  BOREHOLE SELECTION 

5. Click on Create New Site or Borehole (Figure 6-4). 

 

FIGURE 6-5  CREATE NEW BOREHOLE 

6. Click on the Create New Site (Figure 6-5) button and enter the name of the 
new site or accept the default. The site folder will contain all the boreholes 
associated with this new site. Click OK to return to the Create Borehole 
dialog box. Overwrite the default borehole name (optional) and click OK. The 
Borehole Selection screen will be shown listing the newly created site and 
borehole (Figure 6-6). 
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FIGURE 6-6  CREATED NEW BOREHOLE SELECTION 

7. Highlight the borehole and press OK.  

8. Upon selecting a borehole, the program will automatically open the Add Files 
to Borehole dialog box. 

9. To add a file to a borehole, press the Add button. A dialog box will open 
under the path for a specific borehole. If there have additional files in another 
location, the user can navigate to that location at this point (this is usually not 
possible). When the appropriate file has been located, press Open and it will 
be added to the list. Several files can be chosen at once by holding down the 
CTRL or SHIFT keys as appropriate. The software is compatible with several 
file types, as indicated in Section 9. 

10. Information regarding each file is displayed, including whether it is used as a 
base file, the filename, date/time of the survey, depth, interval, units and file 
type. If a file needs to be removed from the list at any time, simply highlight 
that specific file and press the Remove button. If a file needs to be 
temporarily disabled, simply place a check mark in the Disabled box.  
Disabling a file will prevent it from appearing in any plots or text views. 

11. A base file can be specified by highlighting the appropriate file from the list 
and pressing the Base button. An asterisk will appear under the Base column 
confirming the selection. By default, after adding the data to a borehole, 
Inclinalysis™ will set the oldest file as the base file. 

12. Header information is displayed at the top of each plot created by the 
program. Select the file which contains the desired header information by 
highlighting it in the list and pressing the Use for Header button. 

 

NOTE: Header information currently only applies to data with the *.bch file extension 
(see Section 9). 
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13. When completed, press the Apply button to proceed, or press Cancel to 
cancel the action. 

6.2 OPENING AN EXISTING BOREHOLE 

 

NOTE: Before starting, confirm the location and names of all the raw Inclinometer 
datafiles that will be required to display graphs in Inclinalysis™. 

 

1. Under the Borehole menu, select Open Borehole. The following dialog box 
will appear. 

 

FIGURE 6-7  BOREHOLE SELECTION 

2. Press the Browse Files button to navigate to the appropriate directory which 
contains the RST Digital Inclinometer site and borehole files. Upon pressing 
Browse Files, the following screen will appear: 
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FIGURE 6-8  BROWSE FILES DIALOG BOX 

3. Browse for the folder which contains the site and borehole survey files that 
have been taken with the RST Digital Inclinometer system. This is a crucial 
step, as the program looks for a specific directory structure with which it 
recognizes the site and borehole files. Although it is possible to navigate to 
the user’s ActiveSync folder (created by the ActiveSync software), it is highly 
recommended to make a backup copy of this folder and navigate to the 
backup copy of the data. This ensures that no data is lost or corrupted. By 
default, sample files are installed in the Inclinalysis folder in My 
Documents. 

 

CAUTION: Navigation to the correct folder is the most crucial step. The software must 
be set up to point to the correct directory structure where the Digital Inclinometer files 
are located.  

Once the proper directory is specified, the software will automatically update it with the 
site and boreholes that are added to that specific directory.  

For additional information, please see Section 5. To open the sample files, browse to 
the default data file folder (My Documents\Inclinalysis). 

 

4. Once the folder named Inclinalysis is found, highlight it and press OK. 

5. The Borehole Selection screen (Figure 6-7) will re-appear. If the correct folder 
has been chosen (see Section 5), a list of all the current site names will 
appear. Pressing the + button to the left of each site will expand to show all 
the boreholes contained under that specific site. 
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6. For example, Figure 6-7 shows a single site (the Roadway Project), which 
contains a single borehole. Highlight the desired borehole (in this case, 
“Slope Stability”) and press OK. 

7. Upon selection of a borehole, the program will automatically open the Add 
Files to Borehole dialog box (Figure 6-9). 

 

FIGURE 6-9  ADDING FILES 

8. Press the Add button to add a file. A dialog box will open under the path of 
that specific borehole. If, for some reason, there are additional files in another 
location, the user can navigate to that location at this point (this is usually not 
possible). When the appropriate file is located, press Open and it will be 
added to the list. Several files can be chosen at once by holding down the 
CTRL or SHIFT keys as appropriate. This software is compatible with several 
file types as indicated in Section 9.  

9. Information regarding each file is displayed, including whether it is used as a 
base file, the filename, date/time of the survey, depth, interval, units and file 
type. If at any time the user wishes to remove a file from the list, simply 
highlight that specific file and press the Remove button. If a file needs to be 
temporarily disabled, simply place a check mark in the Disabled box. Once a 
file is disabled, it will no longer appear in any plots or text views. 

10. A base file can be specified by highlighting the appropriate file from the list 
and pressing the Base button. An asterisk will appear under the Base 
column, confirming the selection. By default, after adding the data to a 
borehole, Inclinalysis™ will set the oldest file as the base file. 

11. Header information is displayed at the top of each plot created by the 
program. Select the file which contains the desired header information by 
highlighting it in the list and pressing the Use for Header button. 
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NOTE: Header information currently only applies to data with the *.bch file extension 
(see Section 9). 

 
12. When completed, press the Apply button, or press Cancel to cancel the 

action. 

6.3 PRINTING 

Located under the Borehole menu, the print function will print the active window to a 
local or network printer. The user also has the option of printing the entire report by 
selecting Print Report located in the Borehole Menu Report fly out menu. 

6.4 METAFILE EXPORT 

It is often necessary to place the plotted graph into a word processing document. 
This can be accomplished by using the Export Metafile option available under the 
Borehole menu. Exported metafiles can be loaded into photo editing software, 
cropped, and imported into the word processor. This file is created in the Borehole 
Directory by default.  
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6.5 CREATING REPORTS 

The user can create a Report at any time by choosing the Report Save As… 
feature found under the Borehole Menu. A report is useful if several different users 
are manipulating data for a single borehole and wish to have different plots for the 
same set of data. A report saves the current plot and text views with their associated 
properties. The active report is always displayed in the bottom right-hand corner of 
the screen as shown below. 

 

FIGURE 6-10  REPORT LABEL 

 

NOTE: When a report is open, any changes are saved automatically by the program. 
Therefore, once a report name is created, changes made to it occur automatically. 
This eliminates the need to save the report continuously. 

 
 
 
 
 
 
 
 
 
 

 

Report Label 
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Reports can be organized under the Report → Open option. When selected, the 
following dialog box will appear: 
 

 

FIGURE 6-11  OPEN REPORT DIALOG 

This dialog permits the adjustment of all reports that exist for the current borehole. 
New reports can be created, deleted, saved or renamed. Inclinalysis™ will always 
open the most recently adjusted report upon start-up. 
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7 CREATING PLOTS 

Once a borehole is selected and the specific survey files are opened (Section 6.1), 
various plots can be created. By pressing Apply (Figure 6-9), the program will 
automatically create a graph view of the data (Figure 7-1). 

 

FIGURE 7-1  AXIS VIEW 

This plot represents a single axis view which is created in its own separate window.  

 

 

 

 

 

 

 



 

Inclinalysis™: Digital Inclinometer System Software 
Instruction Manual 

 
 

ICM0074H 

Released: 24-Sep-2024 

RST Instruments Ltd. Page 22  

 

Additional windows with different plots can be created by choosing New View under 
the View menu. 

 

FIGURE 7-2  CREATING A NEW VIEW 

The program provides the option of creating a graph view, text view, vector plot, or a 
time plot. 

Shortcut keys are provided along the top tool bar which allow the user to create plots 
quickly and easily. Simply click on the desired plot type and the plot will be created in 
the current graph view window (time and vector plots will open in a new window). 
Available options for graphing include mean deviation, incremental displacement, 
absolute position, cumulative displacement and checksum. Different plot types are 
explained in Section 3. 

7.1 SAVING VIEWS 

Once a view is created, it can be saved under a unique name by selecting View, 
Save or Save As…. Similarly, many different views can be saved under unique 
names. 

Each saved view will have its unique settings for Scale, Graph Colors, Drawings, 
Callouts, Layers, Header, and Footer. 
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Views can be grouped together into reports to keep views organized. See Section 
6.5 for further reading. 

 

NOTE: Click ‘Save View’ after modifying any view settings. This will ensure that any 
changes are saved into view file. It is recommended that each view be given a 
meaningful name, so they can easily be retrieved. Closing unused views will keep 
graph area tidy and speed up the software refresh time. 

 

7.2 PLOT HEADER/TITLE 

The graph title block reflects the information contained in the file that was chosen for 
the Main Header under the Add Files dialog box (refer to Section 6.1). This 
information can be edited or changed at any time by choosing Header located under 
the Edit menu. Alternatively, this dialog can also be accessed by right clicking the 
title block of any plot. 

 

FIGURE 7-3  EDIT – MAIN HEADER DIALOG BOX 

The header is broken down into four main sections: 

1. Title – Provides the option of hiding/showing the title, and changing its colour (left 
click on the colour box). The header font can be adjusted by pressing the Font 
button. 

2. Information Block – This can be made visible or hidden. The font can be adjusted 
by pressing the Font button. Header information can also be edited here.  
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• The Insert Icon… button launches a dialog which allows the user to 
insert an icon, logo or other graphic into the header. This icon can be 
placed to the left, right, or middle of the information block. The icon will be 
visible if the information block is also visible.  

• Location, Northing, Easting and Collar are text information fields, 
editable by the user. 

• Applied Azimuth allows rotating of the plot axis if azimuth correction is 
desired. This value is used by the Inclinalysis™ software to recalculate 
data; it represents displacements in the desired direction only. Enter the 
azimuth of the new A+ axis in the counterclockwise direction from the 
grooves marked as A+. Alternatively, the negative azimuth value would 
represent the azimuth of the new A+ axis in the clockwise direction.   

• The default Collar Elevation is 0, unless edited by the user. Enter the 
desired collar elevation into the Edit box. The depth values on all graphs 
will be altered to reflect collar elevation. The data files are not changed 
when collar elevation is edited.  

 

NOTE: Project name, depth and base reading cannot be changed, as these are read 
from the survey data file itself. 

 

3. Custom Title – custom text can be placed in the plot’s header. Text can be typed 
into the blank dialog box. 

4. Margins – header margins are in inches and can be adjusted by changing the 
values in the corresponding dialog boxes. 
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7.3 TEXT VIEW 

A text view opens a window so the user can view both the raw and calculated data in 
table format. To open a new text view, choose New View → Text View under the 
View menu. A screen like the one in Figure 7-4 will appear. 

 

FIGURE 7-4  TEXT VIEW 

The left-hand column displays the current datasets loaded and active in the report (if 
certain datasets have been disabled in the Add/Remove Borehole Menu, they will 
not be displayed here).  By expanding the branch next to each file in the left-hand 
column, details on that specific dataset are revealed. These include reading units, 
reading date/time, hole depth, depth interval, and file location. Bullets along the top 
of the screen allow the user to view each data adjustment type (raw data, mean 
deviation, incremental displacement, absolute position, cumulative displacement and 
checksum). 

The raw or calculated data displayed in the Text View can be exported by selecting 
Export TextView Data… under the Borehole menu. The exported data file will be 
automatically named (using the nomenclature described below) and saved in CSV 
format in the same folder as the original data file. For example, if the data file is 
“BH2_3.csv” and the Incremental Displacement data type is selected, the exported 
and automatically saved file will be called “BH2_3.csv.Incremental.TextView.csv” and 
will be saved in the same folder as the original file. Here are a few more 
nomenclature examples: 

• BH2_5.csv (Mean Deviation) →  BH2_5.csv.Mean.TextView.csv 

• FraserBorehole3.bch (Absolute Position) → 
FraserBorehole3.bch.Absolute.TextView.csv 



 

Inclinalysis™: Digital Inclinometer System Software 
Instruction Manual 

 
 

ICM0074H 

Released: 24-Sep-2024 

RST Instruments Ltd. Page 26  

 

• dh93cc6s1.csv (Cumulative Displacement) →  
dh93cc6s1.csv.Cumulative.TextView.csv 

• P3-4(1).rpp (Checksum)  →  P3-4(1).rpp.Checksum.TextView.csv 

• North_10453.csv (Raw Data) →  North_10453.csv.RawData.TextView.csv 

 
NOTE: Calculated data includes any applied spiral and axis azimuth corrections. 

 

8 MANIPULATING PLOTS 

Once a plot is created, it can be adjusted to better facilitate data analysis. 

8.1 PLOT OPTIONS 

At any time, right clicking the mouse on the plot area will bring up a list of options 
(Figure 8-1). These options are described in detail in the following sections. 

 

FIGURE 8-1  PLOT OPTIONS 

Plot Options 
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8.1.1 The Cursor 

The cursor can be used to identify specific data points on the graph, and to take 
direct measurements from the graph. This can be a powerful tool if the difference 
between two points on a plot needs to be determined. 

The cursor fly-out has the following options: 

 

FIGURE 8-2  CURSOR OPTIONS 

• Setting the cursor to Free allows it to be placed anywhere within the plot 
area.  

• Snap To Point will snap the cursor on any specific data point within the plot.  

• Lock To Point locks the cursor on a particular point in a specific data set.  

• If the Link Cursors option is selected, the cursors on both the A and B axis 
plots are tied together. Placing the cursor on a point on the A-axis also moves 
the cursor to the complimentary point on the B-axis (please note that cursors 
are only linked if the snap to point and lock to point options are selected).  

• Selecting Set Measure Point places a measurement point in the current 
cursor position. This allows the user to make a quick measurement between 
the set point and the subsequent cursor position. To view the resulting 
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measurement, the cursor text must be set to Measurement and the 
measurement point must be set to visible. 

• Selecting Properties brings up the following screen: 

 

FIGURE 8-3  CURSOR PROPERTIES 

Various options are available to change the cursor properties: 

• The top portion of the dialog box allows the user to show or hide the cursor, 
change its colour and show or hide the static measurement point.   

• Using the drop-down box for Location positions the reported text around the 
crosshairs of the cursor.   

• The Text drop-down box gives the user the options of none, reading, depth, 
depth/reading, measurement or file name. 

• Cursor geometry is adjusted by the drop-down menus in the center of this 
window. These options include style and horizontal and vertical length.   

• The data point style and size can be adjusted by the drop-down menus at the 
bottom the window. 
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Cursor properties can also be accessed by left-clicking the + icon in the bottom left-
hand corner of the plot screen (Section 8.1.7). The status of the cursor is revealed by 
the letter in subscript beside the icon: 

• +F = Free 

• +L = Lock to Plot 

• +S = Snap to Point 

8.1.2 Panning 

Selecting the Pan option allows the user to choose between panning in the x only, y 
only, or both the x and y directions simultaneously. 

 

FIGURE 8-4  PAN OPTIONS 

Panning can also be selected by clicking on the hand icon in the bottom left corner of 
the screen. Clicking with the left mouse button reveals the same options as the pan 
menu (Section 8.1.7). 
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8.1.3 Zoom Functions 

The Zoom option allows the user to zoom a single axis or both axes. 

 

FIGURE 8-5  ZOOM OPTIONS 

Zoom options can also be accessed by left clicking the magnifying glass icon at the 
bottom left-hand corner of the screen (Section 8.1.7). 
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8.1.4 Axis Properties 

Options that are available under the axis fly outs are Properties, Auto Scale, and 
Link Axis. The following dialog box will appear: 

 

FIGURE 8-6  AXIS OPTIONS 
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X-axis and Y-axis properties can be adjusted by selecting them from this list, or by 
right clicking directly the axis of interest.  Axis properties appear as follows: 

 

FIGURE 8-7  AXIS SCALE 
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Various features are presented which can be used to adjust the X-axis (Figure 8-7).  
A similar dialog box opens when changing the properties of the Y-axis.  Options 
include Scale, Units, Label, Ticks and Gridlines: 

• Scale – This option adjusts the scale of each axis. A minimum and maximum 
range can be specified. If the user desires, enabling Centre Graph gives the 
option of specifying a center point and a range for the data instead of a 
minimum and maximum (Figure 8-8). Graph major and minor units can either 
be set manually, by typing the values in the appropriate boxes, or 
automatically by placing a checkmark beside the Auto option. Base Units 
centers the plot scale around that unit (default is zero). 

 

FIGURE 8-8  CENTER GRAPH OPTION 
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• Units – The specific unit of measurement is automatically set by the 
properties of the Inclinometer survey data (i.e. if the survey is taken in mm, 
the program will plot the data in mm). This dialog gives the user the option to 
set the notation (general or scientific) of the axis labels and the number of 
significant figures displayed. The font properties (size, colour etc.) can also 
be edited. See Figure 8-9. 

 

FIGURE 8-9  AXIS UNITS 
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• Label – Selecting the label tab (Figure 8-10), the user can reveal/hide the 
units label and specify a custom label. The font colour can be adjusted by 
clicking on the colour box and the font properties by clicking on the Font… 
button. 

 

FIGURE 8-10  AXIS LABEL 

 

 

 

 

 

 

 

 

 

 

 

 



 

Inclinalysis™: Digital Inclinometer System Software 
Instruction Manual 

 
 

ICM0074H 

Released: 24-Sep-2024 

RST Instruments Ltd. Page 36  

 

• Ticks – Major and minor ticks for each axis can be adjusted by selecting the 
Ticks tab (Figure 8-11). Options available allow the editing of both size and 
placement of the major and minor ticks.  

 

FIGURE 8-11  AXIS TICKS 

• Grid Lines – The colour, size and shape of the gridlines can be adjusted 
under the Gridlines tab (Figure 8-12). 

 

FIGURE 8-12  AXIS GRIDLINES 
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8.1.5 Graph Properties 

Various graph properties can be adjusted through the Graph Properties fly out, as 
illustrated in Figure 8-13. 

 

FIGURE 8-13  GRAPH OPTIONS 

• Add Files to View… – This option displays a screen showing the 
Inclinometer survey files which have been assigned to the specific plot or 
view (Figure 8-14).  The same function is located under the View menu (Add 
Files to View…).  For information on adding and removing files for the 
complete borehole/report please refer to Figure 6-9 and associated 
discussion. 
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FIGURE 8-14  ADD FILES TO VIEW 

This function is particularly useful if there are large numbers of datasets, and 
the user only wishes to plot a few of those datasets. In this case, the user 
would select Include All, and then would remove the check mark for those 
files that are to be included. Next, press the Invert Included button and those 
files that were just un-checked would now be included and the others 
excluded.  The window can also allow the user to auto select the most recent 
files and hide certain files temporarily. 

 

NOTE: Individual survey files can also be hidden by left-clicking directly on the file of 
interest on the graph legend. Clicking again reveals the file. 

 

• Header – points the user to the same dialog as shown in Figure 7-3. For 
more information, please refer to Section 7.2. 
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• Title – Clicking the title option displays the following screen: 

 

FIGURE 8-15  GRAPH TITLE 

This option allows the user to specify a custom title for the graph, change the 
position of that title and choose a specific font, size and style. 

• Footer – Clicking the footer tab displays the following screen: 

 

FIGURE 8-16  GRAPH FOOTER 
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Any text required in the footer can be typed into the dialog box. Footer 
alignment, position, specific font, style and size can also be adjusted. 

 

FIGURE 8-17  GRAPH GENERAL 

• The General options tab allows the user to change appearance of the 
graphs: 

o Graph Area Settings: the user can change background colours of the 
plot and graph areas (simply click on the colour box for a list of 
colours). The annotation textbox drop shadow effect can be disabled 
by placing check mark in the checkbox. To change the graph display 
order (draw plots in time descending order newest first), place 
checkmark into Draw Plots Descending. 

o Custom View Settings: all user customizable settings are saved after 
pressing the Save Current Settings button. For the instructions on 
how to selectively activate custom settings, refer to Section 8.1.4. 

o Plot Custom Properties: click on Edit Custom Properties to modify 
settings saved in previous step. See Figure 8-18 for the sample 
dialog. 

o Display: The user can choose between plotting both A and B axes at 
the same time or plotting a single axis. 
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FIGURE 8-18  CUSTOM PLOT PROPERTIES 

• Plot Properties – opens a new window displaying the current files loaded in 
the borehole. Left clicking directly on one of these files will bring up the 
following dialog: 

 

FIGURE 8-19  GRAPH AND PLOT PROPERTIES 

The plot properties settings allow the user to change the way each data set 
is displayed on the graph. If any settings were modified using the General 
options tab, this step overrides those settings allowing further customization 
of the graph display. Settings include the colour (click on the colour box for a 
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list of options), line width, line style, point size, and point style. The plot name 
can be changed by pressing the Plot Name… button. This permits a custom 
name for a specific dataset.  When finished, press OK, or else press Cancel. 
To exit the full plot properties window, simply close it, minimize it, or use the 
windows menu to arrange the currently active windows. 

 

NOTE: The Plot Properties function is a global command in Inclinalysis™. Therefore, 
all datasets which have been added to a report will be shown in the Plot Properties 
window. This includes datasets which have been disabled in the Add/Remove 
Borehole Files menu. Any changes to the Plot Properties will affect all plots created 
in the report. 

 

8.1.6 Legend 

 

FIGURE 8-20  LEGEND OPTIONS 

The legend can be made visible or hidden by choosing Show Legend. The physical 
positioning of the legend on the graph can be changed by selecting the desired 
option in the list. When Properties is chosen, the same window is opened as shown 
in Figure 8-19. 

The user also has the option of hiding/revealing specific datasets on the graph.  
Simply left click the specific dataset in the legend and it will hide the data on the plot. 
Left click the dataset once again to reveal it. 
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8.1.7 Shortcut Keys 

Graph adjustment shortcut keys are located in the bottom left-hand corner of all 
plots. These functions are the same as those found under the plot options menu 
(right clicking the plot area). The keys appear as follows: 

 

FIGURE 8-21  GRAPH SHORTCUT KEYS 

The keys represent the cursor, pan, zoom, draw, and annotation functions, 
respectively. To use a key, simply left click on one to select it.  

8.2 GRAPH COORDINATES 

At all times, the true coordinates of the cursor are reported in the bottom right-hand 
corner of the graphing window. 

 

NOTE: The graph coordinates reported in the bottom right-hand corner of the screen 
represent the true position of the cursor within the data file. In order to take a 
measurement on the graph, the user must enable the text on the cursor itself and set 
the text options to Measurement, which is found in the cursor properties dialog box 
(Section 8.1.1). 

 

8.3 TOP AND BOTTOM REFERENCE 

In general, most Inclinometer installations are designed to be completed in stable 
ground. Cumulative Displacement plots are thus created assuming that the base of 
the borehole is at “zero” displacement. Data is summed from the base of the 
borehole to the top of the borehole (in the same manner as the Inclinometer survey 
is performed). 

However, in certain situations the base of the Inclinometer case may not be in stable 
ground, and the user may instead wish to use the top of the borehole as the 
reference point. Inclinalysis™ provides the option of changing this reference as 
outlined below. 

 

NOTE: Inclinalysis™ defaults to a bottom reference for Cumulative Displacement 
plots, as this is the most common setting for most applications. 
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To change the reference setting: 

1. Under the Edit menu, select Reference… and the following dialog will appear: 

 

FIGURE 8-22  BOREHOLE REFERENCE 

2. Select the desired reference type and press OK. 

Inclinalysis™ will automatically correct the reference point for the data. 

 

NOTE: Since it is not measured, there is no data for the tilt at depth 0. It is assumed 
that at depth 0, the tilt will be 0. 

 

The graph can be artificially extended to depth 0 by checking Affix collar at (0,0). 
A similar option is given to draw cumulative graphs with common origin. 

 

 

 

 

 

 

 

 

 



 

Inclinalysis™: Digital Inclinometer System Software 
Instruction Manual 

 
 

ICM0074H 

Released: 24-Sep-2024 

RST Instruments Ltd. Page 45  

 

8.4 DEPTH DROP-DOWN BOX 

The depth drop-down box can be found the main toolbar of the program (shown in 
Figure 8-23).  

 

FIGURE 8-23  DEPTH DROP-DOWN BOX 

Selecting a depth from this box will highlight that data point on every data display 
window currently open in the program. This way, the user can directly compare a 
point on the graph (with the cursor visible) to the corresponding data point in a text 
view. The following steps outline an example of how this can be achieved: 

1. Create a plot of the cumulative displacement. 

2. Make the cursor visible and select the Lock to Plot Option (see Section 
8.1.1). 

3. Lock the cursor to the dataset of interest. 

4. Create a new text view. 

5. Under the Window Menu choose Tile Vertically to display both these 
graphs side-by-side on the screen. 

6. Click on the Depth drop-down box and choose a depth either with the mouse 
or by using the arrow keys. The depths can be scrolled through by using the 
arrow keys provided the cursor focus is placed with the drop-down box. 

Depth Drop Down Box 
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7. The corresponding data points will be highlighted on both the graphs. Similar 
actions can be used with the time and vector plots. 

8.5 READING UNITS 

The user has the option of specifying what types of units are displayed in the x-axis 
of each plot. Available units include millimeters, meters, inches and feet. To change 
the units, go to the Edit menu and select Reading Units.  Choose the desired unit 
from the window fly-out list (Figure 8-24): 

 

FIGURE 8-24  READING UNITS 

 

NOTE: Reading units cannot be changed while a text view is active. Please make an 
axis, time or vector plot active before changing the reading units. Once adjusted, the 
user can return to the text view and the change will have taken effect 
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8.6 DEPTH UNITS 

The y-axis units are automatically set to meters or feet depending on whether the 
data files were recorded using a metric or imperial Inclinometer Probe. Inclinalysis™ 
software gives users the option to recalculate the y-axis scale and make it display 
either meters or feet depth units. To activate custom depth units display, uncheck the 
Data Based option under the Edit menu and select the desired units.  

The choice of depth units will be reflected on all graphs and dialogs for all boreholes. 

 

FIGURE 8-25  DEPTH UNITS 

 

 

NOTE: The Custom Depth unit option is provided mainly for graph display. Data 
interval conversions may result in fractional numbers and certain features will use 
rounded values.  

It is recommended to switch to native data file depth units when changing data 
display properties. 
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8.7 MOVEMENT ZONE 

Depth movement over a specific zone can be shown using a custom depth range in 
Inclinalysis™. This is called the Movement Zone. Please note that the Movement 
Zone function only applies to the time and vector plots. 

The Time Plot function displays the cumulative value of displacement at one selected 
depth over time. This depth can be selected in the main menu of Inclinalysis.  It is not 
possible to display a time plot for a range of depths on one graph. 

 

CAUTION: The Time Plot function displays displacement at only one depth over time.  
It is not possible to display a time plot for a range of depths on a single graph. 

 

The Movement Zone function is disabled by default. When this is the case, the 
bottom reference is the bottom of the borehole. When the Movement Zone is 
enabled, the bottom reference is set to the depth defined in the Movement Zone 
dialog box. 

Similarly, when the Movement Zone function is disabled, the data is referenced to 
the top of the borehole. When enabled, the top reference is set to the depth defined 
in the Movement Zone dialog box. 

 The following steps outline how to define and display a movement zone: 

1. Click on a time or vector plot to make it active. 

2. Under the Edit menu, select Movement Zone…. The following screen will 
appear: 

 

FIGURE 8-26  MOVEMENT ZONE DIALOG 
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3. To enable the movement zone, place a check in the upper box. The range of the 
zone can be specified by typing the desired values into the appropriate boxes. 
Top of Zone applies to top referenced plots, and Bottom of Zone applies to 
bottom referenced plots. Refer to Section 8.3 for reference point selection. 

Once enabled, the user-defined movement zone will appear in the title of both the 
Time and Vector plots. The depth drop-down box can be used to scroll through the 
zone if desired (Section 8.3). It is useful to turn the cursor on and set the cursor text 
to display Reading. The date of each survey file will be displayed when points are 
chosen on the Time Plot. Using this method, the history of movement for a specific 
zone is easy to trace. 

 

NOTE: Movement Zone settings are part of Graph View.  

Each individual Graph View can have separate Movement Zone settings. 

 

8.8 BIAS-SHIFT CORRECTION 

If the Inclinometer Probe is suspended in an absolutely vertical position, it will 
typically read a non-zero value. This is the Probe’s bias, or zero, offset. When the 
Probe is newly manufactured in the factory, this value is exceedingly small, however 
over the life of the Probe this value will tend to shift. This is the result of the normal 
bumps and shocks that occur during shipping and normal use. Mishandling of the 
Probe can lead to its bias increasing at a greater rate and magnitude.   

RST recommends that the Digital Inclinometer Probe be returned to the factory for 
calibration annually, or more frequently if the Probe is mishandled and the data 
reflects this. 

In general, bias shifts are not of huge concern as the bias is virtually eliminated by 
passing the Inclinometer twice through the casing (once in the A+ direction and once 
in the A- direction). 

Bias-shift errors occur when the data processing is unable to completely eliminate 
the bias. This occurs when the bias changes between surveys. The bias-shift can be 
systemic, therefore propagating itself as a linear error on cumulative displacement 
plots. Data will appear to have a horizontal translation in relation to other datasets. 

The most common factors leading to bias-shift are: 

1. Mishandling of the Probe: This can range from bumping the Probe on the side 
of the Inclinometer casing to accidentally dropping the Probe.  

 

CAUTION: Always store the Probe in its case when transporting it and when it is not in 
use. 
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2. Inadequate warm-up time: As indicated in the Digital Inclinometer System 
Manual, warm-up time is crucial when performing an Inclinometer survey.  After 
the Probe is lowered to the bottom of the hole, the user must wait at least 10 
minutes to allow the Probe to adjust to the temperature in the bottom of the 
borehole. Failure to do so will result in a bias-shift error for the first 10 minutes of 
readings as the Probe is pulled upwards. As the Probe is adjusting to the 
temperature, the bias-shift will drift and will show apparent movement in the 
bottom of the borehole. 

Inclinalysis™ provides an easy way to correct data for systematic bias-shift errors.  It 
allows a separate correction for both the A and B axes. This is because each sensor 
will generate its own bias shift. The correction is only applied to an individual dataset 
according to the amount of bias that has occurred during the time of the survey. 

The following steps outline how to correct for bias-shift: 

1. Launch Inclinalysis™ and open a Cumulative or Incremental Displacement 
plot. Bias-shift errors will tend to show up most prominently on a Cumulative 
plot as it is a systemic error. 

2. Under the Edit menu, choose Bias-Shift Correction….  A dialog box like the 
Add/Remove Borehole Files… option will appear (Figure 8-27). 

 

FIGURE 8-27  BIAS-SHIFT CORRECTION DIALOG BOX 
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3. Select the desired survey file and press the Bias-Shift Correction button. In 
Figure 8-27, the file BH2_2.csv was chosen. The following dialog box will 
appear: 

 

FIGURE 8-28  BIAS SHIFT PROPERTIES 

4. Be sure to place a checkmark in the box labelled Enable Correction. 

5. Enter the Depth and the Reference Point for the bias-shift correction (Figure 
8-28). The Reference Point is the location on the graph that the user would 
like that data to pass through. Inclinalysis™ will automatically adjust the rest 
of the data points to correspond with the plot passing through this reference 
point. This example makes the A-axis plot for the file BH2_2.csv pass through 
10 mm at a depth of 10 meters.  

6. Press OK when complete. 

7. With the bias-shift correction enabled, **bias will appear next to the specified 
dataset on the plot and the data will be shifted according to the factors 
entered above. 



 

Inclinalysis™: Digital Inclinometer System Software 
Instruction Manual 

 
 

ICM0074H 

Released: 24-Sep-2024 

RST Instruments Ltd. Page 52  

 

 

FIGURE 8-29  BIAS CORRECTION EXAMPLE 

8. The bias-shift correction will occur globally on all plots (including time and 
vector plots) with the exception of the checksum plot. 

 

CAUTION: If wanted, the cursor can be used to determine the reference point for the 
bias-shift correction. This can be done by enabling the snap-to-plot function and 
displaying the graph coordinates. The user can place the cursor on an existing point of 
a dataset and correct another dataset to pass through the same point.  

For more information on the other functions of the cursor, please refer to Section 
8.1.1. 
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8.9 SPIRAL CORRECTION 

The RST Digital Spiral Probe is used to determine the true azimuth of Inclinometer 
casing after installation. Spiral is typically of concern in deep installations, however, 
should poor installation be suspected, or an installed spiral needs to be accounted 
for, a spiral survey can be conducted using this tool. Inclinalysis™ can read the spiral 
data file and perform a spiral correction automatically. Inclinalysis™ currently 
supports Spiral Survey Files from the RST Digital Spiral Probe. Spiral data files 
produced by the SINCO Spiral Probe can be converted to RST Spiral format using 
the Spiral file Format Converter utility included on Inclinalysis™ installation CD. 

For the RST System, the spiral data will be stored in a *.csv file format on the Pocket 
PCTM. Using the SINCO Spiral Tool, the data must be downloaded with the DMM for 
Windows software and then exported. Please refer to section 10.2 for further 
information. 

For additional information on performing a spiral survey please refer to both the RST 
Digital Inclinometer System Manual and the RST Digital Spiral Probe Manual 
(available on the RST Instruments website). 

The following procedure outlines how to apply the spiral correction to a set of 
Inclinometer survey data: 

1. Once a spiral survey has been completed, copy the spiral survey file (*.twi or 
*.txt) to the appropriate site and borehole file on the desktop computer in the 
same way a new Inclinometer survey file would be copied. 

2. Under the Edit Menu, select Spiral Correction…. 

3. A dialog box will appear that shows the current Inclinometer survey files 
which are loaded into the report (Figure 8-29).  Press Add and navigate to 
the location where the spiral survey file in *.csv format (RST) was placed. If 
the file was copied to the borehole directory, it would appear on the list with 
the rest of the survey files. 

4. Press Open and the file will be added to the current list of files. 

 

 

 

 

 

 

5. Press Apply and the spiral correction will be automatically performed on the 
current data sets. Confirmation of the spiral correction will be shown in the 

https://rstinstruments.com/product/digital-inclinometer-system/
https://rstinstruments.com/product/digital-inclinometer-system/
https://rstinstruments.com/product/digital-inclinometer-spiral-sensor/


 

Inclinalysis™: Digital Inclinometer System Software 
Instruction Manual 

 
 

ICM0074H 

Released: 24-Sep-2024 

RST Instruments Ltd. Page 54  

 

top right of the title bar, which should read “Spiral Correction: Enabled”, as 
shown in Figure 8-31: 

 

FIGURE 8-30  SPIRAL CORRECTION DIALOG 

 

FIGURE 8-31  SPIRAL CORRECTION 

To disable the spiral correction, choose Add/Remove Borehole Files… under the 
Borehole Menu (Figure 8-30). Check the box to the left of the spiral file (*.twi or *.txt) 
to disable it.  
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8.10 INDICATING LAYERS ON A GRAPH 

To indicate layers of settlement underground, the area between layer borders can be 
filled with pattern or solid color. 

To add a layer fill, click on the Layers button on main toolbar. The Layers Edit 
dialog box will appear, as shown in Figure 8-32. 

 

FIGURE 8-32  LAYERS EDIT 

Click the Insert button to add a new layer to the list. In the Edit Layer dialog, enter 
the “from” and ‘to” depths, layer color and select the pattern or solid color option. The 
layer name is an optional label. Refer to Figure 8-33 for sample data entry. 

 

FIGURE 8-33  EDIT LAYER 

Figure 8-34 shows Layers Edit dialog box with several entries. 
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FIGURE 8-34  SAMPLE LAYERS 

To edit existing layers, double-click on the desired entry or select it from the list and 
click Edit Selected. To remove unwanted entries, use Delete Selected or Delete 
All.  

When using patterns to fill layer regions, the Borders check box can be selected to 
draw bounding lines to clearly indicate layers. 

Layers can be individually hidden by checking boxes in the first column. Alternatively, 
all layers can be hidden by checking Hide All Layers checkbox. 

If required, label font, location and background color are adjustable using appropriate 
buttons. 

 

 

 

8.11 ANNOTATING PLOT POINTS WITH CALLOUTS 

Users can create descriptive callouts for each point on the plot by right clicking in the 
graph area and selecting the Annotation option. Notes and comments can be added 
to the graph. 
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Annotation can also be selected by clicking on the text icon   in the bottom left 
corner of the screen (see red circle, Figure 8-35). Clicking with the left mouse button 
shows the same options as the annotation menu (see green square, Figure 8-35; 
see Section 8.1.7 for more details).  

 

FIGURE 8-35  ANNOTATION CALLOUTS 

Select Point from the annotation menu and then click on the desired plot point to 
choose the callout anchor. The red dot snaps to the nearest plot point indicating the 
choice made. Click on Callout to begin creating a Textbox (Figure 8-36) or choose 
Paste to insert previously copied callout. 

Choose Properties from the right click menu or double-click the text box to edit the 
text or appearance of the callout box. 

 

FIGURE 8-36  ANNOTATION TEXT 
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FIGURE 8-37  ANNOTATION CALLOUT PROPERTIES 

In the Callout Properties dialog box (Figure 8-37), various aspects of the callout’s 
appearance can be changed: 

• Line Properties: modify style, width and color of the line. Enable or disable 
the callout box border and arrowhead. 

• Line Attachment: Change the line and box joining point. 

• Text Box Properties: Specify fill color; enable or disable the callout box 
border. Check the Transparent check box to make a transparent callout box. 
Box corners can be rounded by selecting Round Border Corners checkbox. 

• Global Properties: change text box shadow and text margins for all callouts 
on the graph sheet. 

 

The location of each callout box can be changed by right clicking on the graph area 

and selecting Move or by clicking on the text icon  in the lower left corner of the 
screen. The selected callout box can be dragged into the desired location, 
duplicated, copied onto the clipboard or deleted. The anchor point can be dragged to 
any point on displayed plots. All edits can be undone by using the Undo command. 

In the case of overlapping callout boxes, use the To front or To back commands to 
change the order. 
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8.12 ANNOTATING GRAPHS WITH TEXT BOXES AND LINES 

Text boxes, like callouts can be inserted anywhere on graph area. Right click on the 
graph area and select the Draw option from the right click graph menu and then 
choose Textbox or line element. Alternatively, the Draw option can also be selected 

by clicking on the line and Textbox icon   in the bottom left corner of the screen.  
Clicking with the left mouse button shows the same options as the Draw menu 
(Section 8.1.7). 

Choose Properties from the right click menu or double-click on the drawing element 
to edit the text or the appearance. 

The selected drawing element can be dragged into the desired location, duplicated, 
copied onto the clipboard or deleted. 

 

FIGURE 8-38  DRAWING TEXT BOXES AND LINES 

All drawing elements feature anchoring properties. The following modes can be 
chosen for every individual drawing element: 

• Scalable mode is enabled when the Scalable check box is checked. The size 
and location of the drawing element are tied to the axis coordinates. Scale 
and unit changes will be reflected in changes to the location and size of 
drawing elements. 
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• Anchored point mode is enabled when the Scalable check box is cleared. 
Only one point of the drawing element will be adjusted when the coordinate 
system changes. Other element dimensions are fixed. The anchor point can 
be chosen individually for each element. In the case of the Textbox, top-left or 
bottom-right corners can be selected as an anchor. For the line element, one 
of the line ends is designated as the anchoring point. 

 

FIGURE 8-39  LINE PROPERTIES 

8.13 SOFTWARE OPTIONS 

The global software options (Figure 8-40) are included in the following dialog box. To 
selectively activate custom view settings, click on the Settings button. Refer to 
Section 8.14 for detailed instructions on selecting and saving custom view settings.  

 

CAUTION: The Advanced button opens the Advanced Settings dialog box. These 
settings are for diagnostic use only. They should not be enabled for normal program 
use; if diagnostic features are used incorrectly, an incorrect graph may be displayed. 

 

 

FIGURE 8-40  SOFTWARE OPTIONS 
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8.14 DATA INTERPOLATION 

In certain cases, survey data is collected at intervals greater than the Probe length. 
Data is automatically interpolated by averaging adjacent points readings. Data 
interpolation is turned on by default in the Advanced settings dialog (see Section 
8.13). 

 

CAUTION: Interpolating data should be used with caution. Using measurement 
interval greater than the Probe length will result in approximate graphs which may be 
inaccurate. 

 

 

 

 

 

 

 

 

 

 

8.15 CUSTOM VIEW SETTINGS 

At any time, the current view settings can be saved as custom view settings (Figure 
8-41).  Click on Save Current Settings in the General options tab to save the 
current settings into the Inclinalysis™ configuration file. Refer to Section 8.1.5 for 
description of General Options dialog box.  When the first new view of the graph is 
created, the program will use custom settings if they are activated in Custom View 
Settings Selection dialog box, shown in Figure 8-41.  By default, all settings are 
enabled. This dialog is accessible from Software Options dialog after pressing on the 
Settings button. 
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FIGURE 8-41  CUSTOM VIEW SETTING SELECTION 

8.16 FILLING OR EXCAVATING AT THE BOREHOLE LOCATION, 
CUTOFF DEPTH 

In the case where the borehole collar level changes, the Inclinalysis™ software 
provides the means to adjust ground level accordingly for proper data display. Enter 
the ground level adjustments in Ground Level dialog box, which is accessible from 
Edit menu. Enter a negative value for excavations. Figure 8-42 shows a sample 
entry. 

 

CAUTION: The borehole collar level and be adjusted in increments equal to the Probe 
length only, which is 0.5m or 2ft, depending on depth units. It is also very important to 
enter the correct data. The Inclinalysis™ program will determine if plots need 
adjustment based on provided data. 
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FIGURE 8-42  GROUND LEVEL ADJUSTMENTS 

Each ground level change will be marked on the graph with a line and calendar date. 
To disable ground level markings, clear the Show Mark Line checkbox. 

The Add/Remove Borehole Files table (Figure 6-9) will show which files are 
affected by ground level adjustment. 

The graphs can be plotted representing borehole data for a specified depth. By 
specifying the cutoff depth, Inclinalysis™ will ignore borehole data below the cut off 
depth value. 

 

CAUTION: The cutoff depth is measure from the current collar level.  Changes to the 
collar level will affect the cutoff depth. 
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9 COMPATIBLE FILE TYPES 

The program is compatible with the following file types: 

1. RST Digital Inclinometer Files (*.csv). 

2. RST Analog Inclinometer (*.csv). 

3. RST Analog Inclinometer (GI Format, refer to Section 10.1). 

4. SINCO (*.rpp). 

5. SINCO Spiral Survey (*.rpp, *.txt, *.prn). 

6. BC Hydro (*.bch). 

These file types are automatically recognized by the program in the Add/Remove 
Borehole/Files… screen (Section 6.1). 

 
CAUTION: Inclinalysis™ will not open different files types in the same borehole view. 

 

10 IMPORTING RST INS 5.2 ANALOG INCLINOMETER 

DATA 

10.1 CONVERTING FILES 

Inclinalysis™ can automatically convert the RST Analog Inclinometer data files into 
the *.csv format which is used for plotting graphs in the program.  This is an 
extremely useful function if the user has existing analog Inclinometer data they want 
to plot with Inclinalysis™. The following procedure outlines how to convert the analog 
data file: 

1. Under the Borehole menu, select Open Borehole Site. Either open an 
existing borehole or create a new borehole. If a new borehole is created, the 
data must be copied to the appropriate directory as outlined in the next step. 

2. Using Windows Explorer, copy the analog Inclinometer data to the 
appropriate directory.  For example:  If the user created a new borehole 
called “Test Data” under a site name “RST” then the files should be placed in 
the folder: DigitalInclinometer\RST\Test Data. 

3. In Inclinalysis™, open an existing borehole or the one just created. 

4. Under the Borehole menu, select Add/Remove Borehole Files… and the 
following screen will appear: 
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FIGURE 10-1  CONVERTING ANALOG FILES 

5. Press the Convert Analog Files button. A dialog box will appear showing the 
following: 

 

FIGURE 10-2  ADDING ANALOG FILES 

6. Select whether the analog data has been taken in meters or feet. Place a 
bullet next to the appropriate choice. 
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CAUTION: It is important that the correct depth units are chosen for the survey. If a 
survey is performed in feet, and meters is selected, the data will be plotted incorrectly. 
Ensure to select the correct units. 

 

7. Press the Add button to select the analog files. Navigate to the appropriate 
directory where the analog files are placed (most likely in the borehole 
directory just created). Select a single file or multiple files by using the Ctrl or 
Shift buttons. Press Open when complete. The user will be returned to the 
screen as shown in Figure 10-2. 

8. The analog files chosen will now be listed in the window. Highlight the desired 
file and press Convert File or press Convert All to convert all the files in the 
list. A dialog box will appear, and Analog File Conversion Successful or 
Batch Analog File Conversion Successful will appear if the conversion 
was completed successfully. 

9. Press the Close button. The Add/Remove Borehole Files window will re-
appear. 

10. Press Add to add the newly converted files converted. 

 

NOTE: Converted analog files will be numbered sequentially according to the 
borehole name and date of the survey.   

File naming follows the default naming convention for the Digital Inclinometer. For 
example, suppose a borehole named “Demo” was created and there are a total of 
three surveys. During the conversion of the three files, Inclinalysis™ will name them: 
Demo(1).csv, Demo(2).csv and Demo(3).csv going from oldest to newest.  

Please note that Inclinalysis™ does not keep track of which files are converted. If the 
same data is converted twice, the program will simply delineate the files by number.  

The conversion only needs to be done once. 

 

10.2 USING UNIDOWN SOFTWARE 

Inclinalysis™ can only interpret analog Inclinometer data (INS 5.2) if it is in *.csv file 
format. Data can be uploaded using UNIDOWN and saved directly as a *.csv file.  
The procedure is as follows: 

1. Launch Inclinalysis™ software. 

2. Under the Borehole Menu, select Open. 

3. Press the Create Borehole button and create a new site and borehole 
corresponding to the data to be imported. 

4. To view the INS 5.2 data in Inclinalysis™, the files must be first downloaded 
from the logger as *.csv format. 
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5. Launch UNIDOWN.exe (free software supplied by RST Instruments Ltd.). 

6. Select option C, Configure. 

7. Set the default path to a location where the data is to be placed. It is easiest 
to simply create a temporary directory on the computer’s hard drive to place 
the files and then move them later.  For example, set the default directory to 
C:\INCLO or C:\TEMP.   

Please note that the directory must already exist, UNIDOWN will not create a 
new directory. Windows Explorer can be used to create a new directory. 

8. Select option 3, Inclinometer. 

9. Follow the on-screen instructions to connect to the INS 5.2 logger. 

10. When the desired file is found, select it by using the arrow keys. 

11. Type in an appropriate file name using the 8-character format followed by the 
.csv extension. 

12. Using Windows Explorer, copy the data files from the temporary directory into 
the borehole folder previously created with Inclinalysis™ in steps 1-3 
(above). 

13. Go to Inclinalysis™ and add the data files to the new borehole using the 
Add/Remove Borehole Files function. 

 

NOTE: It is important that the borehole files which are downloaded in *.csv format 
with UNIDOWN are complete files. This means that there is data for every interval 
and there is complete data for surveys in both the A+ and A- directions.  If a borehole 
survey was only completed in a single direction (i.e. the Probe was not turned 180 
degrees and the survey repeated) the data file will not be recognized by 
Inclinalysis™. 
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11 IMPORTING SINCO DATA 

11.1 INCLINOMETER SURVEY FILES 

Inclinalysis™ software can read Slope Indicator DigiTilt data. To do this, the 
Inclinometer survey files must be in the *.rpp file extension format. The following is a 
brief explanation of how to do this using DMM for Windows software.  For further 
information, please refer to the DMM users’ manual provided with the DigiTilt system.  
The manual can also be downloaded from Slope Indicator’s website: 
www.slopeindicator.com. 

1. Launch Inclinalysis™ software. 

2. Under the Borehole Menu, select Open. 

3. Press the Create Borehole button and create a new site and borehole 
corresponding to the data to be imported. 

4. To view the DMM Project data in Inclinalysis™, the files must be first 
converted to *.rpp format. 

5. Open the Project Database in DMM for Windows. 

6. Select the specific dataset to be exported to Inclinalysis™. 

7. Right click that dataset and choose Export To RPP or under the Survey 
Menu, choose Export to RPP. 

8. Navigate to the site and borehole just created in steps 1-3.  The directory 
structure follows the same format as explained in Section 5.  

9. Go back to the Inclinalysis™ program. 

10. Under the Borehole menu, select Open Borehole Site and choose the new 
borehole previously created.  Add the newly imported *.rpp files and select a 
base file. 

11. Once imported with the program, the plot views can be saved as a Report 
(Section 6.5). 

 

NOTE: The user does not have to create a new borehole in which to place the *.rpp 
survey files.  If required, the files can be added to an existing borehole directory.  In 
this manner data can be compared, provided that the same measurement units were 
used during the survey.  It is also extremely important that the depth references 
between two different survey types are the same (i.e. Probe is positioned in the 
same location in the borehole) otherwise the data cannot be compared without 
significant error. 

 

file:///C:/Users/smalik.TERRAINSIGHTS/Downloads/www.slopeindicator.com
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11.2 SPIRAL SURVEY FILES 

Inclinalysis™ can import Slope Indicator’s spiral survey files and apply a spiral 
correction to either RST Digital Inclinometer files or other imported Slope Indicator 
files in *.rpp format (Section 11.1).  The following instructions outline how to import 
the spiral data. 

1. Record a spiral survey as outlined in the SINCO Spiral Sensor Instruction 
Manual (50900199).  Be sure to make a manual record of the Probe’s zero 
offset. 

2. Download the data from the Datamate using DMM for Windows Software. 

3. Highlight the Spiral Survey file in DMM for Windows. 

4. Under the Survey menu, select the Export fly-out and choose any of the 
following options: To RPP(*.rpp), Tab Delimited ASCII (*.txt) or To PCSLIN 
(*.prn).  Inclinalysis™ is compatible with all 3 file types. 

5. Navigate to the directory in which the Inclinometer survey files are located.  
Type a name for the file and press Save. 

6. Follow the instructions outlined in Section 8.9 for applying the spiral 
correction. 

12 USB SECURITY KEY DRIVER INSTALLATION 

The following instructions describe typical driver installation on Microsoft™ Windows 
7 and Microsoft™ Windows 10 platforms. The actual screenshots may differ, but the 
steps will be very similar. 

12.1 MICROSOFT™ WINDOWS 7 AND WINDOWS 10 INSTALLATION 

PROCEDURE 

1. After successful installation of USB Security Key device drivers, the following 
dialog box is displayed. 

 

FIGURE 12-1  USB SECURITY KEY DRIVERS INSTALLED NOTIFICATION 



 

Inclinalysis™: Digital Inclinometer System Software 
Instruction Manual 

 
 

ICM0074H 

Released: 24-Sep-2024 

RST Instruments Ltd. Page 70  

 

2. At this point, the USB key should be inserted into the USB port. 

3. The MS Windows system should detect the new device and display KEYLOK 
Security Key Installer, as shown on Figure 12-2. 

 

FIGURE 12-2  KEYLOK SECURITY KEY INSTALLER 

 

FIGURE 12-3  KEYLOK SECURITY KEY INSTALLER – CHOOSE DRIVER 

4. The Wizard will install device drivers and display the following screen. Click 
Finish to complete the device driver’s installation. 
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FIGURE 12-4  KEYLOK SECURITY KEY INSTALLER – INSTALLATION COMPLETE 

5. After successful installation, the yellow message balloon (Figure 12-5) should 
be shown in the lower right-hand corner stating that all device drivers are 
installed and ready to use. 

 

FIGURE 12-5  NEW HARDWARE INSTALLATION CONFIRMATION 

6. Alternatively, correct installation of the device drivers can be verified by 
navigating to the Windows Control Panel, choosing System and then 
selecting the Hardware tab.  Clicking on Device Manager will bring up the 
following screen: 
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FIGURE 12-6  WINDOWS 7, 10 DEVICE MANAGER 

7. If the driver was installed correctly, the USB Dongle – Software Protection 
Device will appear as in Figure 12-6 above. If the driver has not been 
installed correctly, a yellow exclamation mark will appear next to the device. 
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13 TROUBLESHOOTING 

Problem:  The program will not open or crashes continuously. 

Solution:  Delete the file Inclinalysis.ini and the folder named Default Site from the 
directory in which the program is installed.  Also delete the Default 
Report directory and Graph.ini file from the borehole directory.  Do not 
delete any *.dgi files from the borehole directory. 

Reason:  The *.ini files track all changes being made within the program (auto-save 
feature).  This, in turn, keeps track of the user’s most recent work allowing 
the program to bring up the last borehole being worked on. Sometimes 
these files can become corrupted. 

Problem: The program fails to recognize USB Security Key 

Solution: Windows 7, 8.1 or Windows 10 operating system. 

1. Remove the USB dongle from the USB port. Exit Inclinalysis software if it is 
open. 

2. Run Start → All Programs → RST Instruments→ Inclinalysis → Tools → 
Install Dongle Drivers. 

3. Put a checkmark next to Uninstall. Do not change any other options. 

4. Click Begin Uninstall. Make sure to check remove driver files if the message 
pops up. 

5. The dialog with successful uninstallation message should pop up. Click 
Close. 

6. Run Start → All Programs →RST Instruments→Inclinalysis → Tools → Install 
Dongle Drivers again. 

7. Put a checkmark next to KEYLOK 2 (USB w/Driver) option. Do not change 
any other options. 

8. Click Begin Install. The dialog with successful installation message should 
pop up. Click Close. 

9. Allow installation if any Windows security warnings show up. 

10. Successful driver installation message dialog should pop up. Click Finish. 

11. Plug in the USB Dongle into the USB port. A message balloon should pop up 
stating the successful installation of the device. 

12. Re-start Inclinalysis. 
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FIGURE 13-1  KEYLOK SECURITY KEY MANUAL INSTALLER 

 

Reason: USB Security Key driver installation failed for some reason. 

Problem: The Inclinalysis™ program opens a large number of views. 

Solution: Manage open views using the Select View dialog box that is accessible 
from View → Open View... menu option. In the Select View dialog box, 
delete unwanted views as well as select which views are open. 
Inclinalysis™ software will open only those files that are flagged Open. 

   Sometimes the Inclinalysis™ software opens too many views when 
program is started by double-clicking *.dgi files. To avoid this situation, it 
is recommended to open boreholes using Borehole → Open menu 
selection and then selecting the desired borehole or browse for files. 

Reason: The Inclinalysis™ software opens many configuration files, occasionally 
some files are not written on time by operating system. 

 
NOTE: For further troubleshooting advice, please contact RST Instruments. 
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14 CONTACT US 

This product does not contain any user-serviceable parts. Contact RST for product 
services or repairs. 

• For sales information: sales@rstinstruments.com 

• For technical support: https://support.rstinstruments.com/support/tickets/new  

• Website: www.rstinstruments.com  

• Toll free: 1-800-665-5599 

 

RST Canada Office (Head Quarters) 

Address: 11545 Kingston Street, Maple Ridge, BC, Canada V2X 0Z5 

Telephone: 604-540-1100 

Fax: 604-540-1005 

Business hours: 7:30 a.m. to 5:00 p.m. (PST) Monday to Friday, except holidays 

 

RST UK Office 

Address: Unit 4 Charles Industrial Estate Stowupland Road, Stowmarket Suffolk, UK, 
IP14 5AH 

Telephone: +44 1449 706680 

Business hours: 9:00 a.m. to 6:30 p.m. (GMT) Monday to Friday except holidays 
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